How To Create NetHelp From an Existing Word Document

This tutorial shows how you can easily go from an existing Microsoft Word document to a web-based

system (Doc-To-Help NetHelp) in just a few minutes.

Note that this is not the only way to create a project in Doc-To-Help, it is just one of the many common

uses. Other ways to create projects include:

Create a new project and have Doc-To-Help automatically create a blank Word document. You
can then write your content from scratch using the new document.

Create a new project and have Doc-To-help automatically create a blank XML document. You
can then write your content from scratch using the Doc-To-Help’s editor.

How to Set-Up

Follow these instructions to set up this tutorial:

1.

Download WordToNetHelp.zip from
http://helpcentral.componentone.com/C1KB/Upload/WordToNetHelp.zip and save it to your

local machine.

Unzip the contents (a Word document and an assortment of images) to your machine’s,
Documents or My Documents folder. You should have a new folder named WordTutorialFiles.

Open the Word document and notice that it is an ordinary doucment.

Make sure the latest Doc-To-Help version is installed and open it. Do not close the Getting
Started Wizard when it opens.



The Getting Started Wizard
The first thing to do is create a Doc-To-Help Project.

In the Getting Started Wizard, the Start New Project item is default. Leave it selected or select it and
click Next. The next section of this document will walk you through the New Project Wizard.

|4 Getting Started With Doc-To-Help

Q What Would You Like to Do?

Once you have created or opened a Doc-To-Help project, you can produce as many Help, Print and
Web target outputs as you need. Pick an option below to get started.

@ a Start a New Project
Create a brand new project. You can have Doc-To-Help create new files, or
you can import your own Word, HTML, or XHTML files.

® ﬂ. Open an Existing Project
=
Use this option to browse projects you have already created.

Open a Sample Project
=]
Use this option to open one of our pre-assembled projects.
® t Convert an Existing Help Project to a Doc-To-Help Project
Convert a RoboHelp, HTML Help, WinHelp, or Doc-To-Help 2000 project.

Resources
i# How-To Video Library i# Guided Tour ¥ Free Introductory Webcasts
@ Help . Doc-To-Help Web Site I, Training Information

Show this wizard at startup Next > I l Cancel




The New Project Wizard

The New Project Wizard is a helpful tool that walks you through the most important settings in a project.
Each of the sub-sections below describes, in order, the screens in this wizard.

Step 1: Select New Project Name

In the first screen of the New Project Wizard, name your project (“WordTutorial”, for example).
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Select New Project Name

This is the first step in creating your project. Once you have named your project and chosen
its location, you can specify preferences and then create new files or import files you
already have.

Name Your Project
WordTutorial
Location

C\Users\danb.COMPONENTONE\Documents\My Doc-To-Help Projects\WordTutarial

Please specify the name and location of the new Doc-To-Help project. You can click the
Browse button to display a folder selection dialog box or type the full path into the text box
above.

Please select a location that does not already contain a Doc-To-Help project (a file with a
.d2h extension).
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When you click Next, Doc-To-Help will automatically create the project file and a directory containing
the folders and files you need for your project. Then the Import Project Settings screen will open.



Step 2: Import Project Settings

The Import Project Settings screen allows you to import settings from another project.
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Would You Like to Import Settings From an Existing Project?

You can import settings (styles, output preferences, properties, etc) from an existing project.
If you would like to do so, select the check box below and choose the project (any file with
a.dz2h extension) you would like to import settings from using the Browse button.

MNote that you can import settings later if you prefer.

["] Copy settings from this existing project:
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You don’t need to import settings, so click Next. The Select Default Language screen will open.



Step 3: Select the Default Language

Doc-To-Help allows you to set the default language.
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Select the Default Language
Select the main (default) character set you'd like to use for this project. You will be able to
use other characters too, but selecting the appropriate main language can make your files
smaller in size and more easily readable.
English (United States) -
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Since the document we are importing is written in English, leave the default setting and click Next. The

Select the Default Source Style Sets screen will open.



Step 4: Select the Default Source Style Sets

This screen lets you set the default or add custom templates and styles sheets that will be attached to
your source documents. It is very common to leave the default settings unless you wish to use a non-
standard paper size for printed outputs or you have a style sheet of your own you would like to use.
Note that you can add a style sheet to a project at any time. This is only for convenience.
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Select the Default Source Style Sets

Doc-To-Help can work with Word, HTML, or XHTML (Doc-To-Help's Editor) content and
automatically attaches the appropriate Word template (.dot or .dotx) or style sheet (.CSS)
when new files are created. You can select different style sets or add your own.

Default settings are recommended in most cases. These settings can be easily changed
later.

Select style sheet type:

Full set of styles -

All styles provided with Doc-To-Help will be used in your
HTML and XHTML documents.

Select document template:

Normal 85" x 11" Template (no left indent) - —

This predefined Doc-To-Help template will be used for your - —
Word documents. ]j

Learn more about styles f— =

Leave the default settings and click Next. The Default Target screen will open.



Step 5: Default Target

You can change targets at anytime in Doc-To-Help, but this screen allows you to set the target that will

be selected by default. Since we want to convert our Word document to web-based output, we will
select NetHelp.
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Select the Default Target

A Target is a Doc-To-Help output. Below is the list of available Doc-To-Help Targets. Select
which you'd like to choose for your project default.

You can select any Target once your project is created; your default should be the output you
plan to build most often.

¥ HTML Help 1.x

£ JavaHelp

L& Microsoft Help 2.0
' NetHelp

= Printed Manual

@ WinHelp 4.0

Learn more about targets
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Select the NetHelp target to set the default. Click Next. The Select Document Type screen will open.



Step 6: Select the Initial Document Type

This is where you will tell Doc-To-Help how you want to start your new project. You can start with blank

XML, HTML, or Word documents or import one you already have. We have a document we would like to
use, so we will choose that option.
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Select the Initial Document Type or Import Your Own

In Doc-To-Help, you author and edit your content in Doc-To-Help's editor (XHTML),
Microsoft® Word, or HTML editors. This screen allows you to choose how you would like to
start your project. Doc-To-Help will create the initial files of your choice, you can import
your existing files, or you can start with an empty project.

() XHTML document

Initial documents will appear for editing in Doc-To-Help's built-in editor.
() Microsoft® Word document

Initial documents will appear for editing in Microsoft Word.
() HTML document

Initial documents will appear for editing in an HTML editor (Microsoft FrontPage
and/or Adobe Dreamweaver recommended).

@ I'would like to import my own

Import existing Word, HTML or XHTML files into this project. An import wizard will
appear after the project is created.

() Empty project, no initial document

No initial documents will be created. You can create new or add existing files in the
project editor after the project is created.
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Select the “l would like to import my own” item. When Doc-To-Help creates the project, it will open an
import wizard that will help you select and import your documents.

Click Next and the Confirm Settings screen will open.



Step 7: Confirm Settings
The last screen in the New Project Wizard lets you look over your settings to make sure everything is as
you want it to be.
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Confirm Settings and Create Project

Project File Name: C\Users\danb.COMPONENTOMNE\Documents\My Doc-To-Help Projects\W...
Source Style Sheet: Full set of styles

Source Document Template: Normal 85" x 11" Template (no left indent)

Default Help Target: NetHelp

Initial Document Type: Imported documents

Verify the settings above, then click Finish to create your new project. If you have selected
the "I would like to import my own documents” option, an import wizard will appear after
you click Finish.
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Click Finish to create the project. Doc-To-help will create and open the project and open the Document
Import Wizard to help you move your document(s) into the new project.



Importing Your Word Document

Now that you have set up a project, you are ready to import your document. If you have followed the
steps in the New Project Wizard section, the Document Import Wizard will be open. This tool will help

you import your document(s).

Step 1: Choose the Type of Document
You can import Word, HTML, or XHTML files. We will import a Word file.

L'i/ Document Import Wizard s )

Choose the Type of Document to Import

@ Microsoft Word (.doc or .docx)
HTML HTML {htm or .html)

Pl
x XHTML (xml)
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Choose Microsoft Word (notice you can import .doc or .docx) and click Next to proceed to the next step.



Step 2: Choose How You Would Like to Import

This screen allows you to chose whether you would like to keep your content in Word or convert it to

XHTML for use in Doc-To-Help’s editor. It is important to note that you can continue to work in Word if
you choose to keep your content in Word. This is simply an option.
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What Would You Like to Do?

Doc-To-Help allows you to work in Word or convert the file(s) to XHTML for editing in the
built-in editor.
@ Keep my content in Word

Your files will be added to the project and you can continue working in Word.

) Convert to XHTML

Doc-To-Help will convert your Word file(s) to XHTML and map the styles to the
project style sheet. You will have the option to edit the style map.
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Leave the default selection, Keep my content in Word, and click Next to begin selecting the file (or files)
you would like to import.



Step 3: Select Files or Folders

This screen allows you to choose one or more Word files or and entire folder. For this exercise, we are
importing a file and the images that go along with it. So click the Add folder... button, navigate to the
WordTutorialFiles folder, select it and click OK. Doc-To-Help will ask you if you want to move all the
associated files. You do, do click Yes. You will see all the files in the import wizard.
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Select Files or Folders to be Imported

Doc-To-Help will import all files and folders listed below.
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Click Import to add the files to your project. Doc-To-Help will attach it’s source template (but not change
any existing styles) and physically move the document to your Doc-To-Help project directory.

When the import finishes, click OK in the confirmation screen and the Document will appear in Doc-To-
Help’s document pane.

You are now ready to generate NetHelp!



Generating NetHelp

It really is this easy. Once the document is added to the Doc-To-Help project, you can build a NetHelp
target. Doc-To-Help will use the document’s heading structure to divide it up into topics.

Doc-To-Help is already to set up to generate your Table of Contents, but you need to activate automatic
indexing. To do so, follow these steps:

e Select the Project tab from the toolbar.
e Drop down the Auto-Index menu.
e Select Conceptual.
Doc-To-Help will now automtically index conceptual topic types.

To generate NetHelp, click Build. (The Build button is found in the Target group on the Home tab
located in the ribbon toolbar).

Bonus Step

You may have noticed that the Word document is a plain tutorial only containing information about how
to import a Word document and generate output. Doc-To-Help makes it easy to format this document
for formal printing by adding a cover page, table of contents, index, and footers. You do this by
generating a manual.

To generate a manual, find the Select Target drop-down button in the Target Group on the Home tab
located in the ribbon toolbar and select Manual. When you click Build, Doc-To-Help will generate a
Word document.

If you would like to generate a PDF, you can do so by checking the Generate PDF button found in the
Target properties dialog. Open this dialog launcher by clicking the arrow in the lower right-hand corner
of the Target group.

You will notice that section breaks may not apprea where you would like them, but you can configure
the doucment.

Working With Your Project

Of course, Doc-To-Help gives you many tools to customize and edit your project. Some in Doc-To-Help’s
interface and other in Word. The next sections describe briefly what you can do. See Doc-To-Help’s user
manual for more information.



Working in the Doc-To-Help Interface

Notice the outlook-style panes on the left-hand side of Doc-To-Help's interface. Open these panes to see
and customize items that Doc-To-Help automatically generates, such as the Table of Contents, Index,
and Related Topics. Also notice that a topics grid opens when working in these panes. This grid allows

you to manage your topics.

The ribbon toolbar also gives you access to various settings for your project.

Working in Word

Open the Word document and notice that a Doc-To-Help toolbar has been added to the interface. Use
this toolbar to add elements such as topic links, pop-ups, and more. This toolbar allows you to continue
working in Word so you can write where you are most comfortable.



